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1.0 Limitations and Notes
• Each fire zone must have one bus, which must be class B.

• This application is only for use with audio circuits.

• This application is not for use with polarized signal circuits.

• The maximum current draw of the monitor module is 6.5 mA when the LED 
is on. If the LEDs must flash during an alarm condition, take their current 
draw into account for maximum current limitations for addressable circuits.

• The minimum versions of the amplifiers that work with this application are:

• QAA-5415-70 Rev F

• QAA-5415-25 Rev G

• QAA-5230S-70/25 Rev G

• QAA-5230-70/25 Rev H

• QAA-5160-70/25 Rev H

• This application works with firmware and Configurator software version 
11.9.0 or higher.

Note: In this document, monitor module refers to any of the following:

• MIX-M500SAP(A)

• MIX-M500S(A)

• MRI-M500SAP(A)

• MRI-M500S(A)

!
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2.0 Overview
Split audio is a feature in the MGC Configurator version 11.9.0 and above. It lets installers 
satisfy the requirements of Division B, Part 3.2.4.18 of the National Building Code of Canada 
2015 for residential buildings while using half the number of amplifiers as before.

The National Building Code of Canada requires that speakers in the suites of residential 
buildings be wired on separate circuits from the speakers in other areas, e.g. corridors. 
Previously this was done with 2 amplifiers for each zone: 1 amplifier for the suites, and 1 
amplifier for the other areas in the zone.

This application satisfies the Code by using one bus serving multiple supporting field devices 
in one fire zone. Field devices in suites retain redundancy from an open by using a class A 
circuit. Field devices in other areas must be serviced by a separate supporting field device.

Definitions from CAN/ULC-S524

• CIRCUIT - Conductors connected directly to field devices which provide a control 
unit and/or transponder with field device status information, alarm signalling or 
other functions.

• FIELD DEVICE - A device located remotely from, but connected electrically to a 
control unit and/or transponder to transmit or receive status change information 
(e.g. fire alarm detection or signalling).

• ACTIVE FIELD DEVICE - A field device that can be uniquely identified by a control 
unit and/or transponder to determine its presence and operating status, and which 
may be commanded to operate or to change its operating parameters 
independently of other field devices that share a common circuit.

• SUPPORTING FIELD DEVICE - An active field device that monitors and/or 
controls other field devices on a separate circuit and reports the status of the 
separate circuit to a control unit and/or transponder.

Definition from the Canadian Electrical Code

• BUS - A conductor that serves as a common connection for the corresponding 
conductors of two or more circuits.

Excerpt from the National Building Code of Canada 2015 Division B, Part 3.2.4.18

8) Audible signal devices within a dwelling unit or a suite of residential or care 
occupancy shall be connected to the fire alarm system

a) in a manner such that a single open circuit at one device will not impair the 
operation of other audible signal devices on that same circuit that serve the 
other dwelling units or suites of residential or care occupancy, or

b) on separate signal circuits that are not connected to the devices in any other 
dwelling unit, public corridor or suite of residential or care occupancy.

(See Note A-3.2.4.18.(8) and (9).)

9) In a building or part of thereof classified as a residential or care occupancy,

a) separate circuits shall be provided for audible signal devices on each floor 
area, and

b) audible signal devices within dwelling units or suites of residential or care 
occupancy shall be wired on separate signal circuits from those not within 
dwelling units or suites of residential or care occupancy.

(See Note A-3.2.4.18.(8) and (9).)
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Overview
A-3.2.4.18.(8) and (9) Signal Circuits. Clause 3.2.4.18.(8)(a) permits Class A wiring, or 
Class B wiring with signal circuit isolators located outside of the suites, to serve audible 
signal devices within residential suites.

Clause 3.2.4.18.(8)(b) permits a separate signal circuit to serve each suite without the 
need for signal circuit isolators or Class A wiring.

Open circuits and Class A and Class B wiring circuits are terms defined in CAN/ULC-
S524, “Installation of Fire Alarm Systems.”

Note: For more information, consult the National Building Code of Canada 2015. 
Please review the full text of the code and consult with professional advisors for 
the implications of the code.i
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3.0 Wiring
3.1 Remove the Jumper on MIX-M500SAP(A) or MRI-M500SAP(A)

If you are using the Advanced Protocol MIX-M500SAP(A) or MRI-M500SAP(A) for speaker 
applications with the Mircom QX series of amplifiers, follow these instructions to remove 
jumper J1. The jumper location is shown in Figure 1.

1. Insert a small flat screwdriver into the hole at the top of the unit.

2. Use the screwdriver to push the jumper out through the slot shown in Figure 1. You do 
not need to open the cover.

3. Discard the jumper.

Figure 1    Remove and discard jumper on MIX-M500SAP(A) and MRI-M500SAP(A)

Jumper J1

1.  Insert a small flat-
 head screwdriver
 into this hole.

2. Push the jumper
 out of this slot.
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3.2 Typical Wiring

Figure 2 shows the wiring for a typical installation with split audio. Each physical zone is 
divided into two logical zones: a zone for the other areas, and a zone for the suites. The 
circuits for the other areas are class B, and the circuits for the suites are class A. The audio 
bus must be class B.

Figure 2    A typical installation with split audio

Note: The last monitor module in each bus must have an EOL resistor for supervision: 
22 kΩ for a 15 W circuit and 10 kΩ for a 30 W or 60 W circuit.i

Fire zone 2

Fire zone 1
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M500XA

M500XA
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Monitor module*

Class B audio circuit

Class A audio circuit

Class C data communication 
link to supporting field devices

audio buses 
d to a fire zone
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Class B audio circuit

Class A audio circuit
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}

}
Zone 1 o
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}
}

* "Monitor module" refers to:
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MIX-M500S(A)
MRI-M500SAP(A)
MRI-M500S(A)

Monitor module*

Monitor module*

Monitor module*
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3.3 Typical Wiring with Existing Devices

Figure 3 shows the wiring for a typical installation with split audio and existing devices. Each 
physical zone is divided into two logical zones: a zone for the other areas, and a zone for the 
suites. The circuits for the other areas are class B, and the circuits for the suites are class A. 
The audio bus must be class B.

Figure 3    A typical installation with split audio and existing devices

Note: The last monitor module in each bus must have an EOL resistor for supervision: 
22 kΩ for a 15 W circuit and 10 kΩ for a 30 W or 60 W circuit.i
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Wiring
3.4 Wiring the Monitor Modules

Figure 4    Wiring the monitor modules

3.5 Wiring the Capacitors

Figure 5    SPLIT-AMP-CAP-KIT

The class A audio circuit for suites requires 2 SPLIT-AMP-CAP-KIT capacitors for every 
monitor module. The class B circuits do not require capacitors.

1. Wire one capacitor to terminals T6 and T9.

2. Wire the other capacitor to terminals T7 and T8.

BP BP

00uF35V 100uF35V
uF35V

BP

End of line resistor 
plate with 22 kΩ or 
10 kΩ resistor End of line resistor 

plate with 47 kΩ 
resistor

Class B audio 
circuit for other 
areas

Class B audio bus

2x non-polarized 100 μF 
35V capacitors

Primary path

Class A audio 
circuit for suites

Alternate path

Data communication link

Wiring for:
MIX-M500SAP(A)
MIX-M500S(A)
MRI-M500SAP(A)
MRI-M500S(A)

B
P

B
P

00
uF

35
V 

10
0u

F3
5V

SPLIT-AMP-CAP-KIT comes with 20 
non-polarized 100 μF 35V capacitors 
that have been modified to eliminate issues in 
the field.
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Wiring
3.6 Wiring the M500XA Isolators

Figure 6    Wiring the M500XA isolators

Note: Last isolation 
module on circuit must 
reverse terminal direction

Last isolation module

Data communication 
link

Protected devices
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4.0 Sequence of Events

Figure 7    Sequence of events with 1 alarm

Figure 8    Sequence of events with 2 alarms 2 minutes apart

Figure 9    Sequence of events with 2 alarms 30 seconds apart

NOTE 1 NOTE 2
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SEC   0 30 60 120 180 240 300 360 420 480 540 600

NOTE 1:
NEW ALARM TIMER EXPIRES 
AUTO RESOUND TIMER ACTIVATES  

NOTE 2:

60

NEW ALARM TIMER ACTIVE:
ALL SPEAKERS SOUND UNTIL TIMER EXPIRES

NEW ALARM TIMER
AUTO RESOUND TIMER 600

ZONE 1 ALARM

1 2 3 4 5 6 7 8 9 10 11 12
660 720

AUTO RESOUND TIMER EXPIRES
ALL SIGNALS REACTIVATE

AUTO RESOUND TIMER ACTIVE:
SUITE SPEAKERS ARE SILENCED (CORRIDOR  REMAINS 
ACTIVE) IN ALL ZONES EXCEPT FOR ZONE OF ALARM UNTIL 
AUTO RESOUND TIMER EXPIRES OR SUBSEQUENT ALARM 

NOTE 1
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SEC   0 30 60 120 180 240 300 360 420 480 540 600 660 720

NOTE 1:
NEW ALARM TIMER EXPIRES 
AUTO RESOUND TIMER ACTIVATES

NOTE 2:
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60NEW ALARM TIMER
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NOTE 4:
AUTO RESOUND TIMER EXPIRES
ALL SIGNALS REACTIVATE

13
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AUTO RESOUND TIMER ACTIVE:
SUITE SPEAKERS ARE SILENCED (CORRIDOR  REMAINS 
ACTIVE) IN ALL ZONES EXCEPT FOR ZONE OF ALARM UNTIL 
AUTO RESOUND TIMER EXPIRES OR SUBSEQUENT ALARM 

60

MIN
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AUTO RESOUND TIMER ACTIVATES

NEW ALARM TIMER ACTIVE:
ALL SPEAKERS SOUND UNTIL TIMER EXPIRES

AUTO RESOUND TIMER ACTIVE:
SUITE SPEAKERS ARE SILENCED (CORRIDOR  REMAINS 
ACTIVE) IN ALL ZONES EXCEPT FOR ZONE OF ALARM UNTIL 
AUTO RESOUND TIMER EXPIRES OR SUBSEQUENT ALARM 

NOTE 1

AUTO RESOUND TIMER EXPIRES
ALL SIGNALS REACTIVATE



5.0 Split Audio in the Configurator
This example shows how to set up split audio and suite silence for a residential building.

In this example, there are 2 physical zones as defined by the National Building Code of 
Canada. Each physical zone is divided into two logical zones: a zone for the suites, and a 
zone for the other areas.

To set up split audio you must:

• Add and Tag Input Devices

• Add and Tag Input Zones

• Add a Common Alarm input zone

• Add the monitor modules

• Add Amplifier Cards

• Tag and Correlate Audio Zones

• Correlate the Input Zones with Devices

• Correlate the Common Alarm Input Zone

• Set up Timers

• Correlate the System Statuses

Follow the instructions below to complete these steps.

5.1 Add and Tag Input Devices

1. Add input devices.

2. Double-click in the Tag field and tag each input circuit appropriately. For instance, tag the 
first input circuit Zone 1.

Figure 10 Input circuits

5.2 Add and Tag Input Zones

1. Add input zones to correspond with the physical zones as defined by the National 
Building Code.

2. Double-click in the Tag field and tag each zone appropriately. For instance, tag the first 
zone Zone 1.
13



Split Audio in the Configurator
5.3 Add a Common Alarm input zone

1. Select Base I/O, then select Input Zones.

2. Click Insert -> Add Zone.

3. Click Add, and then click Close.

4. Double-click in the Tag field for the new zone and type Common Alarm.

Figure 11 Common alarm input zone

5. Select the Common Alarm input zone.

6. Click the Advanced Logic tab, and then click Edit.

The Advanced Logic Editor appears.

Figure 12 Advanced logic editor

7. Select the Common Alarm System Status (**-**-**-ST-000) from the list of inputs.

8. Click the arrow button at the top.

9. Type Common Alarm for the Description and Comments.
14



Split Audio in the Configurator
10. Click OK.

Figure 13 Advanced logic for the common alarm input zone

5.4 Add the monitor modules

1. Select Base I/O under the loop adder card.

2. Select the loop that the modules are connected to.

3. Click Insert -> Add Device.

The Add Devices window appears.

Figure 14 Add Devices

4. In the Type menu, select Supv Opt Mod.

5. In the Process As menu, select Signal.

6. In the Number to add box, type the number of modules that are connected. In this 
example, there are 2 modules for each physical zone for a total of 4 modules.

7. Click Add, and then click Close.

8. Double-click in the Tag field and tag each module appropriately, for instance Zone 1 
Suites and Zone 1 Other Areas.
15



Split Audio in the Configurator
In Figure 15, there are 2 modules for each physical zone. One module controls the 
speakers for the suites, and the other module controls the speakers for the other areas.

Figure 15 4 monitor modules

9. To reduce current load, select NF (No Flash) in the F4 column to prevent the module 
from flashing its LED when it is activated.

5.5 Add Amplifier Cards

1. Select Audio Control in the job tree, and then select the loop that contains the 
amplifiers.

2. Click Insert -> Add Amplifier.

The Add Amplifier window appears.

Figure 16 Add Amplifiers

3. In the Amplifier Type menu, select the amplifiers that are connected. Choose the items 
prefaced with Dual: Dual 4 x 15 Watt amp, Dual 2 x 30 Watt amp, or Dual 60 Watt 
amp.

4. Click Add, and then click Close.

5. Double-click in the Tag field and tag each circuit appropriately. For instance, tag the 
circuit for the first fire zone Zone 1 audio bus.

Figure 17 shows 1 dual 15 watt amplifier, for a total of 4 circuits. Only 2 circuits are used, 
because there are only 2 audio buses.

Figure 17 1 dual 15 W amplifier

Attention: The maximum current draw of the monitor module is 6.5 mA when the 
LED is on. If the LEDs must flash during an alarm condition, take their 
current draw into account for maximum current limitations for 
addressable circuits.

!
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Split Audio in the Configurator
5.6 Tag and Correlate Audio Zones

1. Select Audio Control in the job tree, and then select Audio Zones.

By default, each amplifier circuit has 2 audio input zones correlated with it.

2. Click the Signal tab for each audio input zone to see the amplifier circuit that it is 
correlated with.

Figure 18 The Signal tab of an audio input zone showing the correlated amplifier 
circuit

3. Double-click in the Tag field and tag each audio zone appropriately. For instance, tag the 
first audio zone Zone 1 suites.

In Figure 19, 4 zones are used because there are 2 audio buses. The first 2 audio input 
zones, tagged Zone 1 suites and Zone 1 other areas, are correlated with the first 
amplifier circuit, tagged Zone 1 audio bus. The next 2 zones, tagged Zone 2 suites and 
Zone 2 other areas, are correlated with the second amplifier circuit, tagged Zone 2 
audio bus.

Figure 19 Audio input zones
17



Split Audio in the Configurator
4. For each pair of zones that are correlated with the same audio bus, correlate the first 
zone with the suites module, and the second zone with the other areas module:

c. Right-click the first zone correlated with the bus, and then select Add 
Correlations.

Figure 20 Audio input zone - Add Correlations

d. In the Add Correlations window, select the Signal tab, then select the Zone 1 
suites module, and then click Add.

Figure 21 Audio input zone Add Correlations window - Signal tab

e. Click Close.

f. Right-click the second zone, and then select Add Correlations.

g. In the Add Correlations window, select the Signal tab, then select the Zone 1 
other areas module, and then click Add.

h. Click Close.

i. Repeat steps a to f for the next pair of zones correlated with an audio bus, but add 
the Zone 2 suites module to the first zone, and the Zone 2 other areas module to 
the second zone.
18



Split Audio in the Configurator
In Figure 22, the Zone 1 suites audio zone has been correlated with the Zone 1 suites 
module. It is already correlated with the Zone 1 audio bus by default.

Figure 22 Final audio zone correlations

5.7 Correlate the Input Zones with Devices

1. Correlate each input zone that you created in 5.2 with the modules, amplifier circuits, 
and input devices that are located in that physical zone:

a. Right-click the first input zone, and then select Add Correlations.

Figure 23 Input zones - Add Correlations

b. In the Add Correlations window, select the Inputs tab, then select the Zone 1 
input circuit, and then click Add.

Figure 24 Input zone Add Correlations window - Inputs tab

c. Select the Signal tab.

d. Hold down the Ctrl key, then select the Zone 1 suites module, the Zone 1 other 
areas module, and the Zone 1 audio bus.
19



Split Audio in the Configurator
e. Click Add.

Figure 25 Input zone Add Correlations window - Signal tab

f. Click Close.

g. Repeat steps a to f for the second input zone, but add the Zone 2 input circuit to 
the Inputs tab and add the Zone 2 suites module, the Zone 2 other areas 
module, and the Zone 2 audio bus to the Signal tab.

In Figure 26, the first input zone includes the Zone 1 suites module, the Zone 1 other 
areas module, the Zone 1 audio bus in the Signal tab, and the Zone 1 input devices in 
the Inputs tab.

Figure 26 Final input zone correlations - Signal tab

5.8 Correlate the Common Alarm Input Zone

1. Right-click the Common Alarm input zone that you created in step 5.3, and then select 
Add Correlations.

Figure 27 Common Alarm - Add Correlations
20



Split Audio in the Configurator
2. Click the Signal tab and add all the audio buses that you created in step 5.5.

Figure 28 Common Alarm Add Correlations window - Signal tab   

5.9 Set up Timers

1. Select Job Details in the job tree.

2. Set New Alarm to 60 seconds. After 60 seconds, the signals will stop in the correlated 
zones, except the zone where the alarm was initiated.

3. Set Auto Resound to 10 minutes. After 10 minutes, the alarm will sound in all the suites 
if it has not been acknowledged.

4. Set Signal Silence Inhibit to 60 seconds.

5. Set Auto Signal Silence to Disabled.

Figure 29 Timers
21



Split Audio in the Configurator
5.10 Correlate the System Statuses

1. In the job tree, select Common System Status.

2. Correlate New Alarm Active and Auto Suite Resound System Statuses to each 
monitor module that controls suites:

a. Right-click Auto Suite Resound, and then select Add Correlations.

Figure 30 Auto Suite Resound - Add Correlations

b. Hold down the Ctrl key and select each module that controls suites.

Figure 31 Auto Suite Resound Add Correlations window - Signal tab

c. Click Add.

d. Click Close.

e. Right-click New Alarm Active, and then select Add Correlations.

Figure 32 New Alarm Active - Add Correlations

f. Hold down the Ctrl key and select each module that controls suites.

g. Click Add.

h. Click Close.
22



Split Audio in the Configurator
3. Correlate the Common Alarm System Status with each monitor module that controls 
other areas:

a. Right-click Common Alarm, and then select Add Correlations.

Figure 33 Common Alarm - Add Correlations

b. Hold down the Ctrl key and select each module that controls other areas.

Figure 34 Common Alarm Add Correlations window - Signal tab

c. Click Add.

d. Click Close.
23
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6.0 Troubleshooting
Table 1  Troubleshooting

Message on Display when you press and hold the 
INFO button you see...

What it means

ZONE 1 AUDIO CIRCUIT SPEAKER LINE TROUBLE 

NODE 1 BIN 0 SLT 0 #1

The bus for the signal modules 
has an open, short, or the end of 
line resistor is not installed 
correctly.

ZONE 1 SUITE OPEN CIRCUIT TRB 

ND 1 LOOP2 ADDR 101

The signal module output circuit 
has an open or the end of line 
resistor is not installed correctly.

ZONE 1 SUITE SHORT CIRCUIT TRB 

ND 1 LOOP2 ADDR 101

The signal module output circuit 
has a short.

Ensure that the capacitors on 
class A circuits are not shorted.

POS. GROUND FAULT ACTIVE CODE 1B ND 1 CPU 0

ND 1 LOOP2 ADDR 101

There is a ground fault on the 
audio circuits.

1B means a ground fault on the 
bus or signal module output 
circuit.

When the signal module output 
circuits have a negative ground 
fault, the panel displays a 
positive ground fault.
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7.0 Testing
7.1 Testing Automatic Signal Silencing in Suites

1. Activate an alarm condition in one zone.

2. Ensure all speakers sound for 60 seconds.

• After 60 seconds, the suite speakers should silence for 10 minutes except for those in 
the zone that initiated the alarm.

• 11 minutes after the initial alarm, the silenced speaker resounds.

3. Repeat steps 1 and 2, and then queue the microphone.

• All silenced speakers should broadcast and return to silenced mode after push-to-talk is 
released.

4. Repeat steps 1 and 2, and then activate a subsequent alarm. 

• All speakers should activate for 60 seconds and then return to silenced mode except for 
the zones that initiated the alarms.

If test 7.1 fails, review the configuration and ensure that the New Alarm Active status and 
Auto Suite Resound status are correlated to output modules that are assigned to suite 
speakers. Also ensure that the timers are adjusted appropriately on the Job details page.

7.2 Testing for Sound Distortion in Suites

1. Remove one speaker from the suite on floor level to create an open circuit.

2. Activate an alarm condition in one zone.

The primary and secondary paths of the class A circuit should continue to sound.

If the alternate path sounds distorted, ensure that the capacitors are secure and installed 
correctly on the output module.
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